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Microsoft Outlook 

 

Microsoft Outlook is a popular and by far most mature e-

mail client. It offers a slew of options and features that 

will appeal to most EnterGroup users. Outlook also aptly 

serves as a personal information manager, calendar and 

address book features. You will find more information 

about Microsoft Outlook on its product page at: 

 

http://www.microsoft.com/outlook 

 

For this tutorial, we will consider Outlook 2003, which is the latest version of 

Outlook. If you are using a different version of MS Outlook than this tutorial should 

closely resemble the same options and settings. In this tutorial we will learn how to: 

 

� Configure Outlook Client for use with EnterGroup via IMAP or POP 

� Sending Emails 

� Receiving Emails 

� Deleting Emails 

� Backing your Emails using Outlook 

� Export your Emails to EnterGroup folders 

� Export your Contacts to EnterGroup folders 

� Import your Contacts to Outlook 

 

 

 

 

 

 

 

In this tutorial you will learn how to use Outlook 

with your EnterGroup account. You will learn how 

to setup an IMAP or POP account, and also how to 
move your emails and contacts to EnterGroup.  

USING OUTLOOK WITH ENTERGROUP 
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 Configuring Outlook for use with EnterGroup (POP) 

IMAP Users please scroll down to page 3 

 

WHAT IS POP? 

EnterGroup email accounts can be accessed either through your browser [Web-mail] 

or through your desktop email client [POP mail]. Your desktop email client uses the 

Post Office Protocol (POP3) to receive emails - hence the term POP mail.  

The benefit of using a POP client for your mail, as opposed to a Web-based service, 

is that you do not have to be online to read and reply to your emails. With POP, you 

can connect to the Internet and automatically download your messages using any 

popular POP mail client such as MS Outlook, Netscape Messenger, Eudora, etc... 

Once you have received your messages, you can disconnect from the Net.  

Your emails will always be available on your computer for viewing, replying, or 

whatever other purpose even if you are offline! For example, you can compose a new 

email offline; when you next connect to the Net, your client will automatically send 

your messages.  

Modern POP clients offer a host of features ranging from customizable views to 

comprehensive filtering 

If you are already familiar with POP mail clients, use the following information to get 

set-up in a snap!  

Incoming Mail 

(POP3) Server: 

pop.mailanyone.net - Available on port 110 and port 80 for 

firewall users 

Outgoing Mail 

(SMTP) Server: 

smtp.mailanyone.net - Available on port 25 and 2500 for 

firewall users, please also enable SMTP Authentication. 

Account Login: your complete email address 

E-mail address: your complete email address 

Password: Your email address password 

 

Please Note: After you set-up your desktop email client to work with EnterGroup’s 

POP mail, you will still be able to use your Web-mail account. 
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Configuring Outlook for use with EnterGroup (IMAP) 

 

WHAT IS IMAP? 

 

IMAP is a protocol for retrieving e-mail messages. It is similar to POP3 but supports 

additional features. IMAP allows a 2-way communication with your email client and 

the EnterGroup servers. Using IMAP an email client program can not only retrieve 

email but can also manipulate message stored on the server, without having to 

actually retrieve the messages. So messages can be deleted, have their status 

changed, multiple mail boxes can be managed, etc. 

 

CONFIGURING OUTLOOK 

 

Before you start 

You will require some details from when you set up your EnterGroup account. 

You require:  

The IMAP Server Name - imap.mailanyone.net 

The SMTP Server Name - smtp.mailanyone.net 

Your EnterGroup Username - (for the purposes of this tutorial we will use demo) 

Your EnterGroup Password - (for the purposes of this tutorial we will use demo) 

1. Open Outlook 2003 and from the top menus select Tools then Email 

Accounts... 
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2. Select Add a new e-mail account and hit Next > 

 

 

       3. Select IMAP and hit Next > 
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Your Name: Type your name here - this will be the name emails appear to come 

from (in this tutorial we will use John Smith) 

E-mail address: Type in your email address - this will be the address that emails 

appear to come from. 

Incoming mail server (IMAP): this tells Outlook where your emails are stored. 

Type in imap.mailanyone.net 

Incoming mail server (IMAP): this tells Outlook how to send your outgoing email. 

Type in smtp.mailanyone.net 

User Name: type in your EnterGroup user name – your entire email address 

you@your-domain.com. (in this tutorial we will use demo) 

Password: type in your EnterGroup password. 

 

Click the More Settings button. 

 

 

5. Click the Outgoing Server tab. 

6. Check the box My outgoing server (SMTP) requires authentication 
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7. Select Use the same settings as my incoming server - this allows 

EnterGroup servers to confirm your identity for sending mail 

8. Click OK 

9. Click Next > 

 

 

 

10. Click Finish to complete the wizard. 

At this point, if you have entered everything correctly, Outlook should connect to 

EnterGroup and download any messages you have. 

You will see a new folder free within your folder view 
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Sending Emails 

 

To send new emails within Outlook: 

 

1. Click on the New icon from the Toolbar, or just the shortcut Ctrl + N.  

 

 

 

This will bring up the compose email window and after typing your To: address, 

Subject and email message,  

2. Click on the Account menu from the toolbar, and select your EnterGroup 

account.  

3. Finally, click on the Send button or Ctrl + Enter to send your email. 

Sending with the From: address different from EnterGroup 

If you have your domain name or other emails account setup with EnterGroup, you 

might want to send email with those From: email addresses. Unfortunately Outlook 

doesn’t support identities. One workaround is explained below: 

1. When composing a new email, click on View -> From Field.  

2. Enter your desired From: email address in that field. 
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SAVING YOUR SENT-EMAILS TO YOUR ENTERGROUP ACCOUNT 

By default, Outlook will save your sent-emails to its default Sent Items folder. If 

you want to have all your sent emails saved to your EnterGroup Sent Items 

folder instead, follow the steps below: 

1. Open Outlook 2003  

2. Select Tools | Rules and Alerts... from the menu. This leads to: 
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3. Click on New Rule... 

 

 

4. Select Start from a blank rule  

5. Highlight Check messages after sending  

6. Next 
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7. Click on Next and you should see this dialog 

 

 

8. Click on Yes 

 

 

 

9. Select move a copy to the specified folder in the Step1: pane  

10. In the Step2: pane click on the word specified 

 

 

 



 

Have any questions? Email us at tech@entergroup.com 11  

 

 

11. Scroll down, expand imap.hosting-email.net folder and select sent-mail  

12. Click on OK 

 

 

13. Click on Next 

 

 

14.  Step1: Specifiy a name for this rule. Name the rule "Sent Mail"  
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Click on Finish 

 

 

 

15. Click on OK  
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Receiving Emails 

CHECKING EMAILS 

To check your emails, simply click on the ‘Send/Receive’ button from the toolbar. 

Outlook will check for new emails in your subscribed folders. 

 

DOWNLOADING EMAIL HEADERS 

By default, Outlook is set to download your email headers only. This involves 

downloading a list of subject lines of all emails in your IMAP account. To read an 

email, simply click on the subject line, and wait for a few seconds for Outlook to 

retrieves the email from the EnterGroup Server.  

DOWNLOADING SOME ITEMS IN A FOLDER 

After you downloaded the headers, you can mark items to be downloaded from the 

server. When you download messages, they are placed only on your computer. When 

you delete messages, they are removed from both your computer and the server. 

1. In your Inbox, right-click the header, and then click Mark to Download 

Message(s) on the shortcut menu.  

 

 

2. Click on the Send/Receive button to download the selected items. 
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DOWNLOADING ALL ITEMS IN A FOLDER  

You can configure Outlook to download complete emails including their attachment 

from the EnterGroup server.  

1. On the Tools menu, point to Send/Receive, point to Send/Receive Settings, 

and then click Define Send/Receive Groups. 

 

2. Click a group that contains your EnterGroup IMAP account, and then click 

Edit. 

 

 

3. Under Accounts, click your IMAP account. 

4. In the list, select the check box for each folder you want to include when 

checking e-mail, and then select Download complete item including 

attachments. 
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Deleting Emails 

 

When you delete an item in IMAP mode, the message is marked for deletion by 

Outlook. It indicates this by drawing a line through the message. Outlook will not 

actually delete the message from the server until you tell it to.  

 

To remove deleted items from the server so that they will no longer appear or count 

towards your email quota, open the Edit menu and select Purge Deleted Messages. 
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Backing up your Emails 

 

To backup your emails on your local computer, you can use several features of 

Outlook to do so. Below are a few of them: 

 

METHOD I: Drag-and-Drop 

 

Select the message you want to backup. You can select multiple messages by 

pressing the CTRL key. Simply drag and drop the message(s) to the folder you want 

to backup the email(s). Make sure that the folder you have chosen is on a local mail 

folder.   

 

METHOD II – Copy folder to… 

 

If you want to backup a whole folder, you can simply select the folder, and right-click 

it. From the context menu, select Copy ‘FolderName’ (where FolderName is the name 

of the folder you have selected.)   

 

 

This will bring up a pop-window asking you the location whereby you want to paste 

that folder. Select your location by clicking on the destination folder, and finally click 

on the Ok button. 
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METHOD III: Using Mail Rule 

 

White the above outlined methods are straightforward; they may become tedious 

after some time. Another way to do this would be to set up a mail rule that copies all 

messages to your local folders as well. You would use the Outlook Rule Wizard to do 

this. You would setup a mail rule for all messages, and the action would be to "move 

a copy" to a local folder. 

 

If you're not familiar with how to do this, here are the steps that you should follow: 

 

� Click on Tools/Rules Wizard. 

� Make sure the correct mail account is selected in the "Apply changes to this 

folder" drop down menu. 

� Click "New". 

� Choose the "Start from a blank rule" radio button. 

� "Check messages when they arrive" should be highlighted by default. If not, 

click on it. 

� Click Next. 

� On the "Which conditions.." page, do not click any conditions, just click Next. 

� You may be prompted that "This rule will be applied to every message you 

receive". Click Yes. 

� On the "What do you want to do with this message?" page, check "move a 

copy to the specified folder" (do not use "move it to the specified folder". 

� In the rule description box below the list of possible actions, click on the blue 

text "specified" and choose a local folder. This is where copies of your mail 

will go. 

� Click Next. 

� Click Next on the exceptions page, unless you want some of your messages 

to not be copied. In that case, you can add conditions on this page. 

� Type a name for the rule, "Backup Messages" perhaps. 

� Check "Run this rule on messages already in "Inbox", and click Finish.  

 

Backing up of your messages should now be setup. 
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Export your Contacts to EnterGroup 

 

Step 1: Exporting Contacts from Outlook 

 

To export/upload your existing email folders to your EnterGroup account, simply 

select the folder you wish to export, and drag and drop it to the EnterGroup IMAP 

folder tree.  

 

An upload progress window will popup and once upload is completed, it will 

disappear. Your folder will by then be uploaded with all its emails. It will also be 

accessible via your EnterGroup Webmail interface. 
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Export your Contacts to EnterGroup 

 

You must now export your address book from your email client. EnterGroup accepts 

this data in CSV (Comma Delimited format). The following is the step-by-step 

directions for exporting this CSV file from Outlook:  

 

 

1. Click on File, go to Import and Export  

 

 

2. Select Export to a file and click Next  
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3. Select Comma Separated Values (Windows) and click Next  

 

 

4. You should now select the Contacts type folder (Address Book Folder) to 

export and click Next  
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5. You will now want to click on Browse and select a location to save your CSV 

file on your PC.  

 

 

 

6. After clicking Next you will see a screen to confirm an Export of your Contacts 

folder, simply click on Finish 
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Step 2: Importing the Contacts to EnterGroup 

 

We’ll now upload the contact file we just exported to EnterGroup. To do so, login 

your EnterGroup account. 

 

1. Using the Navigation Bar, Click on Contacts 

 

 

2. To the right is a picture of the EnterGroup Settings 

Bar which lists the different pages of setting options 

you can change. On the Settings Bar, click Import 

/ Export Wizard. 

 

3. This will open up the first step page of the wizard as shown below: 

 

 

Select Import/Export: Select Import from email client 

Select Contact Folder: Choose the contact folder to which you want to have 

your contacts imported to. 

Select email client: Choose Microsoft Outlook from the list. 
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4. Click on the Go to Step 2 button to go to the next screen. 

 

 

5. Click on the Browse... button to locate the file where you stored the .CSV file 

you previously exported from Outlook. Click on the Go to Step 3 button. 

 

 

 

6. Choose the action to be performed. You can either select to have your contact 

items to be overwritten or inserted as new record. Click on the Do Import 

Now button when you are done. You should get a congratulations message 

as shown below: 
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Import your Contacts to Outlook 

 

EnterGroup allows you to export your contact to your email client. To import your 

EnterGroup Contact to Outlook, follow the following steps: 

 

Step 1: Exporting the Contacts 

 

1. Using the Navigation Bar, Click on Contacts 

 

 

2. To the right is a picture of the EnterGroup Settings 

Bar which lists the different pages of setting options 

you can change. On the Settings Bar, click Import 

/ Export Wizard. 

 

3. This will open up the first step page of the wizard as shown below: 

 

 

Select Import/Export: Select Export to email client 

Select Contact Folder: Choose the contact folder you which to Export. 

Select email client: Choose Microsoft Outlook from the list. 
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4. Click on Go to Step 2 when you are done.  This will be prompted save a .CSV 

file of your contact folder. 

 

5. Click on the Save button to save the file.  

 

 

Step 2: Importing your Contacts to Outlook 

 

1. Click on File, go to Import and Export  
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2. Select Import from another program or file and click Next  

 

 

3. Select Comma Separated Values (Windows) and click on Next. 
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4. Click on the Browse… button and select the file you saved from EnterGroup. 

Click on Next.  

 

5. You should now select the Contacts type folder (Address Book Folder) to 

export and click Next  

 

 

6. Click on the Finish button on the next screen to begin import. 


